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System Requirements

In this topic:

1. Server requirements

General notes

a bk wbd

Client requirements

SQL installation notes
Using Azure and Amazon Web Services to host the database

This topic refers to the 4Matrix Network Manager, which is used to install and manage the 4Matrix
database, and the 4Matrix Desktop Client app. Both applications are lightweight and the system
requirements are below.

The requirements to install 4Matrix Infinity (the free web add-on) are available on request from

help.4Matrix.com.

For SQL Server requirements, please refer to Microsoft guidance: https://docs.microsoft.com/en-
us/sql/sql-server/install/planning-a-sql-server-installation?view=sql-server-ver15

1. Server (4Matrix Network Manager application and Database)

Component

Hard Disk

Display

Internet

Memory

Processor

Operating System

SQL Server

Requirement

1 GB (Minimum)
2 GB (Recommended)

800 x 600, 256 colours (Minimum)
1024 x 768 high colour, 32-bit (Recommended)

Required

1 GB (Minimum)
8 GB (Recommended)

1 GHz Pentium processor or equivalent (Minimum)
2GHz Pentium processor or equivalent (Recommended)

Windows Server 2012 or Windows Vista (Minimum)
Also supported: Windows 11; Windows 10; Windows 8; Windows 7;
Windows Server 2016; Windows Server 2019

SQL 2016 Express (Minimum)
SQL 2022 Express (Recommended)

Microsoft Azure and Amazon Web Services (AWS) are both supported for
hosting the 4Matrix database in the cloud, if the school uses either of these
services. There is more information on this below and you can contact us if
you would like further information on setting up your 4Matrix database in
this way.


https://help.4matrix.com
https://docs.microsoft.com/en-us/sql/sql-server/install/planning-a-sql-server-installation?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/sql-server/install/planning-a-sql-server-installation?view=sql-server-ver15

Additional Microsoft .net framework 4.5
Requirements Windows Installer 3.1 or later

2. Client (4Matrix Desktop application)

Component Requirement
Hard Disk 500 MB (Minimum)
Display 800 x 600, 256 colours (Minimum)

1920 x 1080 8-bit (Recommended)

100% text size (Recommended) - Please note that other text sizes may crop
text and buttons within the client application

It is recommended that Data Managers use 4Matrix on a large display of at
least 22" set to the maximum resolution and highest refresh rate.

Internet Required

Memory 512 MB (Minimum)
1 GB (Recommended)

Processor 1 GHz Pentium processor or equivalent (Minimum)
2GHz Pentium processor or equivalent (Recommended)

Operating System Windows Server 2012 or Windows Vista (Minimum)
Also supported: Windows 11; Windows 10; Windows 8; Windows 7

Additional Microsoft .net framework 4.5
Requirements Windows Installer 3.1 or later

3. General Notes

e 4Matrix is a lightweight SQL database-driven, client/server application.

e The 4Matrix Network Manager application and 4Matrix database can be installed and setup in

around 10-15 minutes.

e The Network Manager must be installed locally on the server you wish to host the 4Matrix

Database (unless you're carrying out a standalone installation).

e The Network Manager produces an MSI to install the 4Matrix client software. You can use Group

Policy to deploy this to clients.

e AMatrix can be run from a shared location, if required. Refer to Running From a Shared Folder for

more information.
e [tis recommended that Data Managers use 4Matrix on a large display of at least 22" set to the
maximum resolution. Two monitors may be required if other data management software is to be

used simultaneously.
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. SQL Installation Notes

During the installation process you will have the option to download and install SQL 2016 Express,
SQL 2017 Express, SQL 2019 Express or SQL 2022 Express. Microsoft will cease support for SQL 2016
in July 2026. Therefore, we strongly recommend installing SQL 2017 Express or higher.

e [f you prefer, you can download the relevant installation files from Microsoft directly and install
SQL outside of the Network Manager installation. The only setting to be aware of when installing
SQL manually, when prompted, is to choose 'Mixed Mode Authentication'.

e |f your SQL server is pre-installed, during the installation process you will have the option to 'Use

Existing Server', at which point you will be prompted to enter the sa password for the server.

Please note that older versions of SQL i.e. pre-2016 are no longer supported by Microsoft and we

strongly advise against using these.

[

. Microsoft Azure and Amazon Web Services (AWS)

e These services are supported, should you wish to host the 4Matrix database in the cloud.

e The costs associated with setup and hosting the school's 4Matrix database in this way are at the
school's expense.

e To achieve this, you must first install the 4Matrix Network Manager and database locally, as per
the standard setup. Then, using Microsoft SQL Management Studio, the database can be migrated
from the local SQL server to the Azure/AWS server.

e Once the database is migrated, the user must return to the 4Matrix Network Manager application
and update the server name (when using Azure, this will be something like

schoolname4matrix.database.windows.net).

e The relevent IP addresses must be allowed through the Azure/AWS Firewall, including for any

devices which are to be used from home.

e Deploy the client and Settings file as normal.

6. The Arbor, Bromcom, SIMS, and Wonde Data Extract tools
The data extraction tools that ship with 4Matrix act as a ‘middle-man’ between 4Matrix and the MIS.
They are designed to progressively extract and import a range of data, including:

e Basic Pupil details (name, DOB, gender, ethnicity, postcode, Pupil Premium, SEN, G&T, Form

Group and more)

e Pupil Photos



e (lass data

e Exam results (not applicable to Wonde)

There is not a live link between 4Matrix and the MIS. The extract is a manually initiated task (by a
Data or Exams Manager) which then provides the school with a ‘snap-shot’ of data at any given time.
There is no write-back to the MIS. Note that schools with a hosted SIMS solution will not be able to

use the inbuilt extract tool - reports are provided at www.4Matrix.com/simsreports to use instead.



Quick Installation

In this topic:

1. Summary of Processes

2. What does the 4Matrix Network Manager do?

3. Install 4Matrix Desktop once the Network Manager setup is complete
4. Launching 4Matrix Desktop for the first time

1. Summary of Processes

4Matrix Desktop is designed as a networked application to be used by all levels of staff to share
performance data and carry out research.

It comes in 2 parts; The Server application (4Matrix Network Manager) and the Client application
(4Matrix Desktop). The 4Matrix Network Manager installs the SQL database which 4Matrix Desktop
will connect to and must be installed first. Once this is complete, the client files are generated by the
4Matrix Network Manager, which are then deployed to clients or run as a shared application.

The installation process is broken into a check-list as follows. Each step is covered in greater detail in
subsequent topics, if required.

* Loginat www.4matrix.comand download the full installer

* Run the installer and createthe 4Matrixserver and database

* Choose a location for the 4AMatrix client install files

* Install 4Matrix on clients (or set up as a shared application)

¢ Launch 4Matrixon a test client and check if update is detected.
If it does, ensure that it works as expected

* The first time that you launch 4Matrix you will need to register the
application

€€CCECL

2. What does the 4Matrix Network Manager do?
Once installed, the 4Matrix Network Manager application will manage the installation of the SQL
Server and database that 4Matrix will use. The setup process is designed to walk the user through

these steps with ease.

Usually, this application can be left alone once the initial setup is complete. Possible exceptions to
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this will be if the school decides to move the server that the 4Matrix Database lives on, or when

needing to take or schedule a backup.

Other functions of the 4Matrix Network Manager include:

e |Installing the web add-on, 4Matrix Infinity (please contact support to proceed with this).

e Atool for checking connection statuses and Firewall exception rules.

® Functions to Backup and Restore the 4Matrix Desktop database. Use the Backup option to

manually make a Backup when required, but we recommend using a Windows Task to make

backups automatically (see separate topic).

e Access both the Install Guide and Remote Support from the Help menu.

3. Installing 4Matrix Desktop once the Network Manager setup is complete

L

Navigate to your client set-up folder (as created in Step 3, above). You will find a link to this path

on the main screen of the 4Matrix Network application in the 'Installer Location’ line:

Windows Client Settings

Update Server:
Proxy Server:
Download Folder:
Run Update As:

Installer Location:

http:/fwww dbdatri.com/update
Mo Proxy Required

Use Default

Run as logged in user

L vidl Lilent 5

2. Inside this folder will be the files 4MClient.msi, Settings and LauncherSettings.xml.

Mew Volurne (D:) » 4Matriz » Client Setup

-~

& Mame

i AMClient.msi
| | LauncherSettings.sxml
| | Settings

Date modified Type Size

14/01/2022 11:25 Windows Installer ... 97.554 KB
2170772021 16:09 XML Document 1KB
12/05/2021 13:43 File 1KB

Important: The 4Matrix Network Manager ships with Client MSI version 3.9.4.1. We strongly

recommend downloading the latest MSI from https://www.4Matrix.com/downloads and adding this

to your client set-up folder, replacing the older version. Not seeing LauncherSettings.xml? Download

8/53


https://www.4Matrix.com/downloads

this file from the same link.

3. Onastandalone PC, simply run the 4MClient.msi and work through the install process. If using

Group Policy, use this folder as your deployment package.

Additional client install information:

e For information on configuring 4Matrix to run from a shared folder, please see: Running From a

Shared Folder.

e Using Group Policy, the Settings and LauncherSettings files should automatically 'go' with the
deployment of the msi.

e SCCM users may need to use an argument to force Settings to go with the installation, see

https://www.help.4matrix.com/knowledgebase.php?article=14

4. Quick Reference: Launching 4Matrix Desktop for the first time
1. Launch 4Matrix Desktop from the applications menu or available shortcut.

2. 4Matrix will prompt the user to enter their School ID - this can be found on your Welcome email.
This is a one-time process that licences the database.

3. Once the licence is verified, login using Office or Staff. Use the password Password (with a capital
P). These options may not appear if you are using Active Directory login with 4Matrix.

4] Update 4Matrix Licence E3
£} 4Matrix Licence m Ea Q Search For Key Automatically AMatrix = n
Please enter your school ID, which can be found on your
Running 4M atrix for the ﬁrst time Licence and Registration document to lookup your licence key
) ) schoolm: [ || Findkey Your licence has been updated!
You are nearly ready to start using 4Matrix. The final step is to
licence your software. If you have already purchased a licence, Licence Key B rote School Name: Hawthorns Academy

please press continue.

Expires: 12/09/2017

Purchase a new licence

Cancel

@) Mot Found? Ccancel



https://www.help.4matrix.com/knowledgebase.php?article=14

Standalone Installation Notes

4Matrix is designed as a networked application to be used by all teachers to share performance data
and carry out research. By installing 4Matrix as a standalone application, you will lose many of the
benefits of the 4Matrix school performance system.

However, we are aware that for the purposes of testing 4Matrix, this may be the preferred
(temporary) solution.

Users will work through exactly the same process as if 4Matrix were being installed on to an actual
server - for clarification, the process is to install the 4Matrix Network Manager which will in turn (1)
install an SQL server application to host the 4Matrix database and (2) generate an msi to install the
main 4Matrix application.

The installation process is almost exactly the same as when installing in a server/client scenario, and

you should refer back to previous topics for guidance, noting the points below:

e Follow Step 1: Install Network Manager.

e Follow Step 2: Database Setup. If your laptop/pc is not connected to the schools network, you
may be able to bypass the proxy and custom temp folder settings - check with a member of your
IT team for guidance.

e In Step 3: Create a Client Install Files folder, choose any location that is suitable, such as C:
\4Matrix\ClientSetup or My Documents\4MatrixSetup.

e In Step 4, simply navigate to the Settings folder and run 4MClient.msi to install 4Matrix.
e Follow Step 5: Register 4Matrix.

e To transfer your 4Matrix database from a standalone PC to a server, seethis topic.



Step 1: Install Network Manager

Go to the 4Matrix Downloads page_www.4matrix.com/downloads and log in using your 4Matrix

School ID and password.
e Download the Full Installer.
e Unzip the 4MManager.zip to a known location.
® Run the extracted file 4AMManager.msi and ignore any security messages that you might see.

e Work through the following install sequence:

Click Next to start the installation wizard

Choose the installation folder (C:\4Matrix is recommended)

Click Install to begin the installation process

Wait while files are transferred

Click Finish to complete the wizard

€eeec

e Click Finish to launch the 4Matrix Network Manager application (below). The SQL Server Details
section will be blank at this stage:


http://www.4matrix.com/downloads
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4Matrix Network Manager

RO B

g @ §

Run Refresh Backup Restore Connection Maore Toaols
Wizard  Status Database Database Issues =
Main Database
B sQL Server Details W Run Wizard
Status: Connected

Server Name: MTX-PC-04\SOLEXPR2019

Server Login:

Database:

5a (™)

Wales

Windows Client Settings

Update Server:
Proxy Server:
Download Folder:
Run Update As:

Installer Location:

P Infinity Settings
Update Server:
Version:

AD Server:

http:/ fwww AMatrix.com/update
Mo Proxy Required
Use Default

Run as logged in user

D:AdMatrix\Client Setup

Default

3.9.84

B2 xR O

Re-Copy Launcher Setup  4Matri
Files Settings Guide  Online
Tools

@ Web Server Details
Status:
Site Name:
Root Folder:

Site Address:

@ Change Update Server

@ 2 0

Remote About
Support ™
Help
& Run Wizard

@ Change Update Server

P Start Stop

Above: The 4Matrix Network Manager Application main panel
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Step 2: Database Setup

® C(Click Run Wizard to launch the server and database setup wizard.

e Click Run Wizard in the Network Manager

e Install or use an existing server

e Create your 4Matrix Database

e Enter your Network Settings

€€E€L

The notes below expand on each stage:

e [f you chose to launch the Network Manager manually, or if this is not the first time you have
used the Network Manager, you will be presented with the main application screen - Click the
Run Wizard icon in the top left of the window (or top right of 'Server Details') to begin the client
set-up process as highlighted in red below:

4Matrix Netwd

Ew |
"‘—E T =

Refresh Backup Restore Connection More Tools R
Status Database Database Issues =

viain Database

B sSQL Server Details

Status: Connected
Server Name: MTX-PC-04\SOQLEXPR2019
Server Login: sa (")

Database: Wales

Above: Click Run Wizard to begin the client setup process
e Choose to install a new server or use an existing server (Fig2).
e If installing a new server, give your server a name and assign a password;
The name must:
+ Be between 1 and 15 characters
+ Start with a letter

+ Only contain letters, numbers and the symbols # (hash) and _ (underscore)

13/53
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The password must:
+ Be between 8 and 15 characters
+ Start with a letter

+ Contain at least 2 upper case letters, 2 lower case letters, 2 numbers and 2 special
characters

+ Only contain letters, numbers and the special characters # (hash), _ (underscore), $ (dollar),
£ (pound), % (percentage), ! (exclamation) and ? (question)

Example password: DAtabase20195#

4  amatrix - x Install New SQL Server X

Selecting an SQL Server
Flesse choose an existing server or install 3 new one (recomended) Step 1. Choose a server name

Please enter a name for your new SQL server, a few
suggestions are FOUR, MATRIX or FOURMATRIX

4Matrix uses an SQL Server to store you data centrally, Please choose to either, install a Server Name:
new sql server or use an existing one.

Step 2. Choose a password

« finstall New Server (Recommended) E'ef:e e";e' ? dpf;s‘;md {U' PR B
etween an characters.
Use Existing Server : d
assword:
Server:

Confirm:

Step 3. SQL Version >

Please choose the version of SQL you wish to install. An
additional download may be required.

Edition: iSQL 2019 Express -
Status:
Download Required! Download
This is a Domain Contraller Start Install

Fig2: Installing a new server and giving it a name/password

e Choose the version of SQL Server that you wish to download and install. The default selection is

SQL 2016 Express, but you can also choose 2017, 2019 or 2022.
e Select Download you'll see the following screen:

18 Download SQL Installer X

Download SQL 2019

The following file will be downloaded:

http://help.4matrix.com/files/downloads/sql/2019/x64/SQ1 20 |[I copy
19.exe

When the file has finished downloading, please place it in the following
folder:

Di\dMatrix\Files

Please do not rename the file. Once the file is in place, please press
Complete

@ Start Download VDuwnIoad Complete

e Choose Start Download and wait for the file to be downloaded.

e Place the SQL exe in the 4Matrix Files folder as per the instructions (if not downloaded to that

14753
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folder).

Choose Download Complete and then click Start Install. This process may take up to 15 minutes

depending on the version of SQL you have chosen.

Note: If you receive an error during the SQL installation, close the wizard, and go to your 4Matrix

folder i.e. C:\4Matrix\Files. Run the SQL.exe file and install SQL outside of the 4Matrix installation.

Make sure, when prompted, to use Mixed Mode Authentication. If you see an error during this
installation, it should provide more details. Usually, any errors seen here are because the server

requires a restart. Once installed, open the 4Matrix Network Manager, run wizard, and choose to use

your new (existing) server.

Once the SQL installation is complete, the wizard will continue. The SQL login details will default

to sa (systems administrator) and the password that you entered in the previous step. Click next

(Fig3).

Choose your new database type (England or Wales) and give it a name. We suggest using FOUR or

MATRIX (Fig3). Note that you are installing a new database which contains demo data for your
selected database type. England comes pre-set to demonstrate Progress 8, EBacc, and so on,

whereas Wales is set to show Capped 9, Welsh Bacc, etc. Your default school-type setting can be

changed later on in 4Matrix if the incorrect version is selected.

& amatrix Setup Wizard m

5QL Server Login
Please enter the username and password for your SQL server

Please enter the SQL server admin login details. if you installed a new SQL
server, the username will be 'sa’ and the password will be the one you
entered during setup.

Usermame: [52 |

Password; [T |

Cancel

& amatrix Setup Wizard m

Select Database
Wizard page subtitle: this should help the user complete a subtask

If this is the first time you have run this wizard please enter a name for your
new database, otherwise select your database from the list.

® Install New Database

Mame: MATRIX

Use Existing Database

Unable to create a new database?

If you are having problems creating a database, please checkthe user
NETWORK SERVICE has "Full Control' permissions over the 4Matrix
database folder. dlick here to open the folder.

Cancel

Fig3: SQL login details and creating a 4Matrix database

Note: If you receive an error at this point saying the database cannot be created, you will need to
grant the Network Service full permission over the 4Matrix Database folder.

The next step is important and must be set up correctly to ensure that 4Matrix can update itself on

client workstations (Fig4).

15/53




& 4Matrix Setup Wizard m - E3

Specify Network Settings
Please spedfy a few things about your network

Please answer the following questions about your network, required for the
automatic update system within 4Matrix.

1. Do you use a proxy server to access the internet? () ves @ o
2. Do users have permission to install updates? ® Yes Ho
3. Download updates to a custom temp folder? Yes (@ No

< Back Cancel

Figd: Your Network Settings

1) Do you use a proxy server to access the internet?

If your network uses a proxy server to connect to the network choose Yes and enter the details. You
can find these by going to Internet Explorer and choosing Tools > Internet Options > Connectionsbut
they need to be those that apply to users on the network. You can also type AUTO into the Address
field and a random number in the Port field if you are unsure of the proxy settings.

Note: If you receive an error message after completing these details, make sure the line below your
proxy details is blank, i.e. right click and press delete.

2) Do users have permission to install updates?

There are 2 update 'modes' that the 4Matrix Desktop client can use to automatically update itself
when launched, using either a Windows Service or by running as an Elevated User.

The Windows Service mode is new. We now refer to the Elevated User mode as the legacy option.

If using 4Matrix client msi 3.9.8.0 or higher and a LauncherSettings.xml file, the 'Windows Service'
mode will be the default setup.

e The setting 'Do users have permission to install updates'can be left as YES if using the Windows
Service mode.

e The setting 'Do users have permission to install updates' must be set to NO if you are not using
the Windows Service and users do not have Full Control over the 4Matrix client folder on their
PC’s (e.g. C:\Program Files (x86)\4Matrix). You must enter a different username and password to
run the updates with (Run As). Please note that the updates will be downloaded as the logged in
user, NOT the user specified here. You must include a domain name, i.e. myschool.org\admin;
make sure it is the FULLY QUALIFIED domain.



3) Download updates to a custom temp folder?

By default, updates are downloaded to the logged-in user's temp folder (%temp%). If this folder is
blocked or hidden from users, you can specify a different path e.g. %$USERPROFILE%\4MatrixUpdate

RM Schools: If not using the Windows Service mode, you will need to supply an elevated user to run
updates as, add a custom temp folder, AND give users full control over the 4Matrix folder on their C
drives.

Further reading
e For information on update problems please see: Update Errors

e For information on configuring a custom update server, please see: Custom Update Server

e For information on configuring 4Matrix to run from a shared folder, please see: Running From a
Shared Folder
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Step 3: Create a Settings Folder

The final step (server-side) is to choose a location for the client installation files.

® Choose a location for your client
install files

-

* Deploy the client application or
setup to run as a shared location
J

® Create a folder for your client installation files. You may wish to choose a place like:
P:\Application\Installers\dMatrix\4MClient for example
On an RM network it is usually a location like Q:\Packages\Applications\ etc
DO NOT choose the existing 4Matrix > Files > Client folder as this will cause an error!
e This setup folder will contain the 4Matrix client msi, the Settings file that tells the application the
path to the database, and a LauncherSettings.xml file (which can be downloaded from

https://www.4Matrix.com/downloads)

18/53
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Step 4: Install 4Matrix on Client PCs

¢ Navigate to your client setup folder

e Share these files with client PCs —
install using Group Policy or set
4Matrix up as a shared application

1. Navigate to your client set-up folder (as created in Step 3, above). You will find a link to this path

on the main screen of the 4Matrix Network application in the 'Installer Location’ line:

Windows Client Settings

Update Server:

Proxy Server:

Download Folder:
Run Update As:

Installer Location:

http:/fwww dbdatri.com/update
Mo Proxy Required

Use Default

Run as logged in user

Dadamatrid Client Setup

2. Inside this folder will be the files 4MClient.msi, Settings and LauncherSettings.xml.

Mew Volurne (D:) » 4Matriz » Client Setup

% % % %

)

Mame

-~

i AMClient.msi

|j LauncherSettings.xml

| Settings
L] g

Date modified Type Size

14/01/2022 11:25 Windows Installer ... 97.554 KB

217072027 1609 XML Document 1KB
2/05/2021 13:43 File 1KB

Important: As at 20th January 2022, the 4Matrix Network Manager ships with Client MSI version

3.9.4.1. We strongly recommend downloading the latest MSI from

https://www.4Matrix.com/downloads and adding this to your client set-up folder, replacing the

older version. Not seeing LauncherSettings.xml? Download this file from the same link.
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On a standalone PC, simply run the 4MClient.msi and work through the install process. If using

Group Policy, use this folder as your deployment package.

You can use Group Policy to deploy 4Matrix.

For information on configuring 4Matrix to run from a shared folder, please see: Running From a

Shared Folder

Using Group Policy, the Settings and LauncherSettings files should automatically 'go’ with the
deployment of the msi
SCCM users may need to use an argument to force Settings to go with the installation, see

https://www.help.4matrix.com/knowledgebase.php?article=14
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Step 5: Check Updates Work

Once you have installed 4Matrix on your server or a test client, it is important to test the update
process on a second client if you can - ideally, the PC that belongs to the member of staff that is going
to take a lead on 4Matrix.

Updates are small self-extracting Zip files (.exe) designed to extract to the 4Matrix folder. A
large proportion of our support calls are related to updates failing to install. This is because 4Matrix
has not been set-up correctly.

Please refer to our dedicated guide on updates, which includes a note on how to check updates are
working, here: https://help.4matrix.com/knowledgebase.php?article=208
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Step 6: Register 4Matrix

e Launch 4Matrix from the Start/applications menu.

e Once any updates have been applied, a pop-up will appear confirming this is the first time that

4AMatrix has been run.

e (Click Continue to move to the next step.

£} 4Matrix Licence = E3

Running 4Matrix for the first time

You are nearly ready to start using 4Matrix. The final step is to
licence your software. If you have already purchased a licence,
please press continue.

Purchase a new licence

Cancel

4] Update 4Matrix Licence

@ Search For Key Automatically

Flease enter your school ID, which can be found on your
Licence and Registratian document to lookup your licence key

S — T

Licence Key

B Paste

@) Mot Found?

Cancel

AMatrix

M@

‘Your licence has been updated!

School Mame: Hawthorns Academy

Expires: 12/09/2017

e To register 4Matrix, enter your School ID (refer to your welcome email) and click Find Key.

e AMatrix will then confirm your School Name and licence details. Click OK to start using 4Matrix.

If AMatrix fails to detect your licence key, there are 2 options:

1) Please try whitelisting *www.4matrix.com* , including the asterisks, and try again.

2) If the above also fails, you can copy your licence key from your main account page

www.4matrix.com into the prompt in 4Mat

rix.

22153
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Managing Users

Logging in to 4Matrix

AMatrix [Highgarden Academy]

ZMatrix

Office

a
o

Above: The client login screen
4Matrix comes pre-loaded with 2 'dummy' user accounts: Office and Staff.
The default password for both accounts is 'Password'.
It is possible to create and maintain your own user-accounts in 4Matrix using the Manage Users tool.

Passwords can be changed by the user once logged in to 4Matrix via the File menu, unless this option
is switched off (see Custom Permissions, below).

***Do not delete the Office user unless you have created at least 1 other Admin account.***

Another option is to sync 4Matrix with Active Directory so that 4Matrix bypasses the login screen and
uses the Windows Account.

Active Directory - Basic Setup

4Matrix supports Active Directory (AD) Login, using the Windows Account to login to 4Matrix. To do
this, follow these steps:

e (Create 3 groups in AD on your server:

1) 4MatrixAdmin
2) 4MatrixSLT
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3) 4MatrixUser

***Note that these are case sensitive***
e Add staff accordingly to each group

e For the AD group information to propagate to clients, please force a group policy update and
restart clients. AD Authentication should then be recognised, but if you are experiencing any
issues please contact us at https://help.4matrix.com.

e Update 3.9.5.1 (March 2019) allows for additional AD groups to be utilised. There is more on this
below.

Access Levels/Groups

4Matrix update 3.9.5.1 (March '19) replaces the term 'Access Levels' with 'Groups'. For existing
customers, it is important to note that no changes are required unless you wish to implement custom
permissions, more info below.

By default, there are 3 types of Group in 4Matrix - Admin, SLT and Staff - and each one uses the
following Authentication Key:

1) 4MatrixAdmin

2) 4MatrixSLT

3) 4MatrixUser

It is advised that the school set these up correctly with the correct staff placed in each one for the
following reasons:

e Embargoing exam results - Apart from the Admin user(s), all other user group types can have
series restrictions placed on them. For example, a Results Series uploaded early can be hidden
from all other Groups except the Admin user(s) until Results Day.

e Restricting access to the 4Matrix Admin tab - The SLT and User Groups prevent users in those
Groups from accessing the Admin tab in 4Matrix which is used to upload, edit and manage data.

Default Groups Explained:

Admin - This is the highest Group level. There are not, and cannot be, any restrictions placed on
users that belong to the Admin user Group.

SLT - Does not have access to the Admin Tab in 4Matrix. Can have Series Visibility restrictions set
by Admin Users.

User - Does not have access to the Admin Tab in 4Matrix. Can have Series Visibility restrictions set
by Admin Users.

***The 3 default Groups, 4MatrixUser, 4MatrixSLT and 4MatrixAdmin CANNOT have custom
permissions placed on them®***
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In order to utilise the custom permissions options, new Groups must be created. The exact
permissions that apply to each new Group can be edited within 4Matrix using the Manage Users tool.
This allows for features to be activated or restricted, such as access to specific features under the
Admin tab.

Working with Groups - 4Matrix Login

4Matrix login accounts can be created and managed using the 4Matrix Manage Users tool

When creating a new 4Matrix login account, you MUST choose a Group for the account to be
placed in

The default groups, Admin, SLT and Staff cannot be renamed

The default groups, Admin, SLT and Staff cannot have custom permissions placed on them (more
on this below)

Additional Groups that can have custom permissions applied to them can be created using the
4Matrix Manage Users tool

4Matrix login accounts can be moved between Groups as required

Custom Groups cannot be deleted unless they are empty i.e. they do not contain 4Matrix login
accounts. You must either move or delete user accounts prior to deleting a Group

Working with Groups - Active Directory

Basics - please refer to the section above, 'Active Directory - Basic Setup'
The default groups, Admin, SLT and Staff cannot be renamed

The default groups, Admin, SLT and Staff cannot have custom permissions placed on them (more
on this below)

To utilise additional Groups, you must create a new Group in both 4Matrix AND Active Directory,
noting that it is the Authentication Key name that needs to match the group name in AD. For
example, if you wanted a new Group for 4MatrixTeachingStaff, this must be created in both
4Matrix and AD, noting that the naming convention is case-sensitive, as below:

-
ay= Manage Users

@ Users [l Groups [ Permissions [ History =+ New ¥ Remove Il Export
Name Authentication Key Icon Colour
Staff AMatrixUser & Teacher W, 73125
SLT AMatrixSLT & Manager Il 192, 20, 77
Admin AMA & Administrator I 128, 100, 162
- T i 0,176 20

Above: It is the Authentication Key that needs to match between 4Matrix and AD

All Group memberships MUST be managed in Active Directory
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e Staff Windows Accounts must be placed in the relevant AD group, and they will subsequently
appear in that Group in 4Matrix the next time they log in

e Custom Groups cannot be deleted unless they are empty i.e. they do not contain any staff
accounts. You must either move or delete user accounts prior to deleting a Group, which will
need to be done using AD

e Windows Accounts CANNOT be moved between Groups using 4Matrix. The Group populations
MUST be managed using AD.

Custom Permissions

Update 3.9.5.1 (March '19) adds an option to customise some of the functionality that each user Group
has access to. This is in addition to the Series Visibility options, which are managed by the Admin
user(s) and can be applied to any Group.

It is important to note that if you have setup 4Matrix to work with Active Directory, as per the 'Basics’
section above, no changes are required unless you wish to implement custom permissions, as per

the example below.

***The 3 default Groups, Admin, SLT and Staff CANNOT have custom permissions placed on them***

-
- Manage Users

& Users [l Groups B Permissions | E History Il Export
Groups
Permission Admin SLT Staff Teachers SLT Data Team

0 o |/ o ' o ' o | o |
b L L b v

Change Own Password
Manage KPI Filters
Manage Transition Models
Manage KS3 Statements
Import Data

Above: Editing the Permissions table

It is now possible to toggle the following functions on and off, per user Group type. The location of
the tool/feature is also noted, so, for example, if the Import Data function is toggled ON for
SLTDataTeam, all users in the SLTDataTeam Group will see the Admin tab with all import options:

0 Change Own Password* (File menu)

O Export Data (Admin tab, Export option - Share and Compare)

O Import Data (Admin tab, all Import options)

O Manage CDA (Admin tab, all CDA tools)

O Manage Database (Admin tab, Manage Database)

0 Manage Groups (Home tab, Admin tab - nb: tool still shows but without edit
options)

O Manage Research Groups (Home tab, Admin tab - nb: tool still shows but without edit
options)

O Manage KPI Filters (KPI tool, Subjects Summary)
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O Manage KS3 Statements  (Admin tab, CDA Statement Editor)

0 Manage News Feed (Dashboard)

0 Manage Permissions (Admin tab, Manage Users - nb: relies on Manage Users being
toggled on)

0 Manage Pupils (Admin tab, Edit Pupils, Edit Markbook)

0 Manage Results (Admin tab, Edit Results, Edit Markbook)

0 Manage School (Admin tab, School Settings)

O Manage Series (Admin tab, Edit Series)

0 Manage Subjects (Admin tab, Edit Subjects, Edit Quals)

0 Manage Timetable (Admin tab, Edit Timetable, Edit Classes)

0 Manage Transition Models (Transition Matrices > Edit Models)

0 Manage Users (Admin tab, Manage Users)

* This will not apply when using Active Directory/Windows Accounts

Active Directory - Priority
This feature was first introduced in 4Matrix version 3.9.6.1, issued in November 2019.

When using school-created custom Active Directory Groups with 4Matrix, the Priority field can be
used to determine which Group a user should belong to by default when using 4Matrix, where they
exist in more on than one AD Group.

For example, your school may use two AD Groups 'Admin' and 'User' for different purposes, but a
member of staff exists in both. Both of these AD Groups have been synced with 4Matrix - so how
should the user be treated when using 4Matrix?

The Priority field can help to determine this. It accepts numerical values and is sorted in descending
order i.e. the higher the number, the higher the priority.

Going back to our example, if Windows ID AB12 exists in both 'Admin' and 'User' AD Groups, and we
assign a Priority of 10 to the 'User' Group in 4Matrix (leaving Admin as 0), AB12 will be detected as
being in the 'User' Group when logging in to 4Matrix, with the appropriate permissions.
The default sort order for AD Groups in 4Matrix is as follows:

1. The Priority value

2. The 4Matrix internal id

3. Alphabetically

So, if we left both the 'Admin' and 'User' Groups set Priority = 0, AB12 would be detected as being in
the 'Admin’ Group by 4Matrix as this is the first group it will come across alphabetically.

Other Functions



Export - All tab views contain an Export option in the top right of the main grid.

Removing a user account will remove that user's entries from the History log.

Bulk Import of Users (Legacy)
You can import a list of users into 4Matrix using the Import button (found in Manage Users).

Create a spreadsheet with 3 column headers: Username, Password and Group Name - and populate
accordingly. You can paste your spreadsheet into the dialogue (shown below) or type into the cells as
you would in a spreadsheet:

Import Users () - o x

Select Validate

Please paste in or load a spreadheet with columns for Username, Password and Group Name, Please identify the columns on the right.
Column names will be taken from the top row

4 A B c D E F Columns To Include
1 Username .Password Group Name * Name Inchade As
2 Office Password Admin
-+ | Username Username
: Password Password
: Group Name Group Name
B
7
8
9
10
11
12
13 v
Sheet1 Sheet2 + « »
Exit MNext

Above: Importing users from a spreadsheet



The Demo Database

4Matrix is shipped with a Demonstration School Database pre-installed.

Once 4Matrix starts you will see series data displayed on the dashboard. There are six series for a
2010/11 cohort which you can see using the Change menu on the bottom icon bar.

If no data is showing, check that the date format on your PC is set to UK DD/MM/YYYY (Control Panel >
Regional Settings)

Bear in mind that, although your school name is shown at the top of the application, the data showing
belongs to a completely fictitious school.

This database will allow you to explore the features of 4Matrix fully without having to import your
school’s data.

Let the Admin user know that once they have explored this demonstration database they can delete
it by going to the Admin tab, and then choosing Database > Clear Database

You can make a backup in case you wish to re-install it later for any reason. You can do this using the
Backup Database feature in the 4Matrix Network Manager application.

You can also download the demonstration database as a backup file from
www.4matrix.com/resources and reinstall it using the Restore Database function in the 4Matrix
Network Manager application

Using the Demonstration Database for training

One of the advantages of shipping 4Matrix with the Demonstration School Database is that it can
easily be installed across the computers in an ICT room, ready to run a session on 'using 4Matrix' with
teachers.

Using the demo school makes all the issues neutral for staff.

However, in our experience, teachers want to be able to see their own school’s data.

The training guide for this session can be downloaded from
https://www.4matrix.com/help/4matrix_practical_guide.pdf
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MIS Extract tools

If your school uses Arbor, Bromcom, SIMS or another MIS supported by our Wonde integration, we
recommend testing the Extract tool(s) before handing 4Matrix over to a Data Manager.

File Home cDA Reports

h 4 ™

MIS Spreadsheet  Files Pupil AMatrix  Share &

- - Photos Fusion Compare
@ SIMS
L[ | §
B Bromcom
122)
ILM
} Arbor
49 45
Girls
- 1215 4
Favy Cloud School (Beta) s
t'c'ﬂs Ed:gen (Beta)
~
cmig)  CMIS .

Above: The MIS Extract tools can be found under the Admin tab

The full Application Guide (in 4Matrix, go to Help > Application Guide) provides full details of
importing examination results from your MIS. We advise that you work through atleast steps 1-3 to
ensure that data is extracted correctly. Identifying some examination titles may require the help of
the Examinations officer or Data Manager anyway, so you may wish to show them how to start the
import process when you hand over 4Matrix for them to use.

SIMS must be installed locally in order for the SIMS Extract Tool to work. Hosted versions are not
supported and you will receive one of 2 errors, either the 'SIMS.ini can't be found', or '4Matrix can't
access the SIMS Data Layer'. Please refer to https://www.4matrix.com/simsreports for help with this
setup.

Most other technical issues with this tool are due to problems with network settings, insufficient
folder permissions, the firewall blocking the remote connection port address, or incorrect proxy
settings.

e Bromcom Extract: If you see an error relating to invalid credentials or proxy server authentication
when logging in, check the Admin > School Options tool and go to the MIS tab. You may need to
enter the Bromcom URL if it is not the default cloud.bromcom.com address. This might be
required when a MAT or LA hosts the Bromcom database on the school's behalf. You can also
choose to bypass any proxy servers. (This function replaces the need for the Bromcom Config file,
used in previous versions of 4Matrix).
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4 5School Settings x

s General | & Fusion | = mis | $ Fine Grades | o
+IRIS
Ed:gen
None Arbor Bromcom Cloud School Ed:gen SIMS
‘URL: ‘
|
AP Key: @‘

School ID: ‘

Username: ‘

Password:

Bypass Proxy Server @

Switched MIS? Click here to remove MIS IDs from all entities

Above: Use the School Options > MIS tab to overwrite the default settings for the Bromcom Extract tool

® Please also check the Knowledgebase at https://help.4matrix.com before contacting us as it is

likely that your problem has previously been documented.
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Remote Support

Remote Support is available from both the 4Matrix and Network Manager applications. You can also
access remote support at www.4matrix.com/remote.

Do not attempt to use these services without contacting us first.

We use Teamviewer 14 and LogMeln.

Please make sure your staff are able to use at least one of these applications. In the event that you
require remote support and we are unable to obtain access, you will be asked to contact us again

once you have removed or bypassed your security settings.

Teamviewer should work whenever an internet connection is operational. This uses 80 HTTP, port 443
HTTPs is also being checked. It is also possible to open only port 5938 TCP on the outgoing side.
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Backing Up The 4Matrix Database

You can make a backup of your 4Matrix database at any time using theBackup function (Figl).

4Matrix Network Manager

Run  Refres Restore  Connection More Tools = Re-Copy  Launcher Setup  4Matrix  Remote About
Wizard Status Database [Database Issues - Files Settings Guide  Onlne  Support =
Main Database a] Tools o Help o

Figl: The Backup & Restore function

Notes: If you receive an error when making a backup, choose More Tools > Make Current User Admin
and then try again.

Running Scheduled Backups

e Using Windows Task Scheduler, create a new Basic Task

e Set the Trigger accordingly (i.e. the time and frequency of the process)

e Set the Action to Start a Program

® Inthe Program/Script field, select 4Matrix NetworkManager.exe (most likely in C:\4Matrix)

e Set the Argument to \backup

As an example, the 'Start a Program' settings will look something like this:

Create Basic Task Wizard mel X

"@ Start a Program

Create a Basic Task

Trigger Program/script:

Daily |I:\dMatrix\Netwnrkl\."lanager.exe | Browse...
Action
B rgumerts ool ckup

< Back Next » Cancel

The default location for the backup file to be saved to is (Drive):\4Matrix\Databases\Backups
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This can be changed by adding a text file to this folder called REDIRECT.txt - open this file and type
the folder path that you wish to use instead e.g. I:\New folder

It is also possible to specify a maximum number of databases to keep at any one time in order to
preserve disk space. In (Drive):\4Matrix\Databases\Backups create a text file called AUTO-DELETE.txt
- open this file and type a number, which will refer to the number of days.

So, if you type 30, then a backup will be created every day for 30 days. On the 31st day, a new backup
will be created but the very first backup will be deleted.



Client Launch Errors

Error 26 - Unable to connect to the 4Matrix database

1. Check that the Settings file was installed with the Client - go to the 4Matrix folder and check it
exists, and that it's larger than Okb. If it's not there or shows as Okb, in the 4Matrix Network
Manager, click 'Re Copy Files'. Go to the client files folder and copy the Settings file. Add it to the
4Matrix folder on the client, overwriting the existing version if there is one.

2. If 4Matrix client launches on the server but not the client, this is a good indication that a Firewall
is blocking the client connection to the server. Open the 4Matrix Network Manager on the server
and go to Connections. Ensure that you have made incoming exceptions for both of the paths
shown on this panel.

3. In Services, make sure that the SQL Browser service is started.

4. In SQL Configuration Manager, check that Named Pipes and TCP/IP are enabled.

5. If the Firewall is off, or the exceptions have been made, check that the client can ping the server.

6. The SQL Server name is limited to 15 characters. If the server name is longer than this then you
should replace it with the IP address using the 4Matrix Network Manager. Work through the

wizard, replace the name, and then click Re-Copy Files. Replace the Settings file on the client.

7. Ifit still shows the error, contact us for further help.

Error 28 - problems accessing the 4Matrix server/database

e Check in SQL Configuration Manager that under Protocols for SQLExpress the Named Pipes and
TCP/IP are Enabled.

Error - Problem connecting to database Pre login handshake

e Run the following command in an elevated command prompt 'netsh Winsock reset' - this should

resolve the issue.
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Client Update Errors

This topic has been moved to knowledgebase article which can be accesssed here:
https://help.4matrix.com/knowledgebase.php?article=208
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Custom Update Server

Newer versions of the 4Matrix Network Manager (3.7.4.0 onwards, March 17) support the use of a
custom update server. This allows you to bypass the default setting in which 4Matrix will look to our
website in order to check for updates. It will look to a path on your network instead. Although we do
not recommend this approach due to the potential delay in clients receiving important fixes, you may

need to utilise this option if you experience problems with your proxy server preventing updates, or

if you would simply like to have more control over when the updates are available to clients.

The options for the Update Server are found on the main Network Manager screen:

Windows Client Settings

Update Server: http:/ fwww . 4Matrix.com/update
Proxy Server: Mo Proxy Required

Download Folder: Use Default

Run Update As: Run as logged in user
Installer Location: BdMatrixiClient setup

@ Change Update Server

First of all, click Change Update Server. A dialogue will appear with the default setting:

&} Change Update Server

Update Server Path

- EN

o AMatrix. comjupdate

cancel

Replace this with a path of your choice, for example, C:\4Matrix\CustomUpdate. Click OK.

An additional button will now appear - Refresh Update Server -click this and see if it detects any

updates:

AMatrix Updates

@

There are 9 update(s) available, would you like to download them?

Yes Mo

Wait for the updates to download and then go to the custom folder;
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» This PC » MewVolume () » 4Matrix » CustomUpdate w 0

A

i Name Date modified Type Size
| 3044 06/04,/2017 13:12 1 File
] 3100 ! 0 File
] 3.2.00 0 File
| 3474 1 File
| 3473 3 File
| 3474 4 File
] 3510 0 File
] 3720 0 File
| 3740 0 File
=| Update.bit 06,/04/2017 15:13 Text Document

It may appear as if there are versions missing, this is because some versions are bundled with
others.

When the 4Matrix client application launches it checks the version number in the Update.txt file in
your custom folder. If it detects a higher version than is currently in use in the .txt file then the
update process will begin.

Use the Refresh Update Server option when an update is available and you are ready to add it to this
folder for clients to use. Potentially, this can allow for a set time(s) each term for when updates are
applied, although we do not recommend this approach due to the significance of fixes and
enhancements.

We recommend adding a Newsletter contact email address to your account at www.4matrix.com. We
will use this to notify the contact when an update is available and include a changes list. It is possible
to add more than one contact to this list using the Plus button next to the first field. We will not use
the email address(es) for any other purpose other than to notify the user of updates and important
information relating to 4Matrix, such as Results Day preparation information. For help with update
issues, please go to http://www.4matrix.com/help/update help.pdf
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Group Policy - File Deployment

If you have trouble with the 4Matrix Settings file copying to clients, or if you need to deploy a 4Matrix
LauncherSettings file, you can use the 1-page guidance document at this link for help:
https://www.4matrix.com/help/deploy file.pdf
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Moving Servers

This topic has been moved to separate document which can be downloaded from:
http://www.4matrix.com/help/moving_servers.pdf
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Problems Installing Network Manager

If you receive an error message when creating a new database, please work through the following
steps:

e Open the 4Matrix folder on your server (usually C:\4Matrix)
e Right click the Databases folder and go to Properties

e Go to Advanced

e Go to Effective Permissions

e Click Select (to the right of the 'Group or username field)

e Type Network Service in the and click Check Names, it should underline the words NETWORK
SERVICE

e C(lick OK

e Go to Permissions

e (lick Change Permissions

e C(lick Add and type Network Service, and Check Name

e C(lick OK

e This brings up a pop up where you can specify permissions. Grant full permissions and click OK

e Click OK on all windows until finished

Try creating the database again, and it should now work.

It is also possible that pending Windows updates are preventing the installation - try restarting the
server and re-running the Network Manager.



RDS Server Setup

You can install the 4Matrix Desktop application on an RDS server and allow access to this from outside
of school.

With this setup, multiple users will be running the same version of 4Matrix, so it is important to
switch updates off so that the files do not try to update when in use, which would cause them to
corrupt. You do this by placing a file called LauncherSettings into the 4Matrix directory. This is a text
file, with editable parameters that allow you switch updates off and on.

Install the 4Matrix application on to the RDS server

Download LauncherSettings from www.4matrix.com/files/downloads/LauncherSettings.xml
Place LauncherSettings in the 4Matrix folder and open it with Notepad

Leave CheckForUpdates to true, e.g. <CheckForUpdates>true</CheckForUpdates>

Set DownloadUpdates to false e.g. <DownloadUpdates>false</DownloadUpdates>

Save the file and check that 4Matrix still opens without issue by running Launcher.exe

When this shortcut is run, the software will check for updates but not download them. It will only
warn the user if it detects that an update is available, and they will see an option to open 4Matrix
anyway.

To manually update the software the Network Administrator should:

e Ensure that no-one is running 4Matrix from this location (we suggest unsharing the 4Matrix folder
temporarily)

e Set DownloadUpdates to true e.g. <DownloadUpdates>true</DownloadUpdates> and save the
file
Run Launcher.exe to apply the updates

e Set DownloadUpdates back to false e.g. <DownloadUpdates>false</DownloadUpdates> and save
the file

e re-share the folder (if required)

You can also add your email to our update notifications list, which you can do by logging into your
account at www.4matrix.com and adding a News Letter Contact.
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Running From a Shared Folder

Although installing 4Matrix locally onto clients is the recommended setup, it is possible to run
4Matrix from a shared folder.

You will need a LauncherSettings.xml file to help control the update process and set it so that the
4Matrix files are cached locally to the client when it's launched.

Download a LauncherSettings.xml file from here:
www.4matrix.com/files/downloads/LauncherSettings.xml

Note: LauncherSettings.xml file must be used with a client msi/installation that is later than 3.9.5.0.
The latest msi is available from www.4matrix.com/downloads

The LauncherSettings file contains the following parameters, each of which are explained in more
detail:

<DebugMode>false</DebugMode> <!-- Set this to true to show all event messages -->

<UpdateMode>1</UpdateMode> <!-- Set this to 1 to run updates as Admin, or 2,3 or4 torunasa
Windows Service. More info at https://www.4matrix.com/help/update_help_new.pdf -->

<CheckForUpdates>true</CheckForUpdates> <!-- If true, will attempt to check for updates. If false,
this step will be skipped -->

<DownloadUpdates>true</DownloadUpdates> <!-- If true, updates will be downloaded and
installed. If false, only a message showing available updates will be displayed before continuing -->

<UnzipUpdatesToSubFolder>false</UnzipUpdatesToSubFolder> <!-- If true, updates will be
unzipped to a subfolder called Updates. If false, updates will be installed as normal. This should only
be used in conjuntion with CopyLocal-->

<OverrideTempFolder>false</OverrideTempFolder> <!-- If true, updates will be downloaded to the
custom temp folder specified below (required). If false, updates will be downloaded to usual
location-->

<CustomTempFolder /> <!-- Required if OverrideTempFolder is true e.g. <CustomTempFolder>C:
\Program Files\4matrix\Temp</CustomTempFolder>-->

<CopylLocal>false</CopylLocal> <!-- If true, files will be copied and run from the location specified

below. If false, files will run as normal. This is useful for running from a shared folder and caching
files on local PCs-->

<CopyLocalPath /> <!-- Required if CopyLocal is true e.g. <CopyLocalPath>N:
\4Matrix</CopyLocalPath>-->

<UseShellExecute>false</UseShellExecute> <!-- This parameter can be used to help resolve update
problems. Possible values are true, false, Default-->

<UseVerbRunAs>true</UseVerbRunAs> <!-- This parameter can be used to help resolve update
problems. Possible values are true, false, Default-->
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<ApplyUseShellExecute>false</ApplyUseShellExecute> <!-- This parameter can be used to help
resolve update problems. Possible values are true, false, Default-->

<ApplyUseVerbRunAs>false</ApplyUseVerbRunAs> <!-- This parameter can be used to help resolve
update problems. Possible values are true, false, Default-->

<EventlLoglocation /><!--This parameter can be used to help resolve problems with stability issues.
The 4Matrix log is automatically written to My Documents but if users cannot write here, this can be a
cause of the errors. Specifying a custom location my resolve the issues anyway, but if not, the log will
contain more detail-->

Option 1: The Cache Model with Auto-Updates (RECOMMENDED)

Install the 4Matrix application to a shared folder on your server e.g. P:\Apps\4Matrix

e (Create the LauncherSettings.xml file (as above) in this folder

e Open the LauncherSettings.xml file with Notepad

® Set the Copylocal to <CopyLocal>true</CopylLocal> and CopyLocalPath to a path users have full
permission to e.g. <CopyLocalPath>%USERPROFILE%\4MatrixTemp</CopyLocalPath>and save
the file

e (Create a shortcut to P:\Apps\4Matrix\Launcher.exe and share with staff e.g. place on their

desktop

e When this shortcut is run on the client, the Launcher will create a cached copy of 4Matrix locally
in the path specified. This eliminates issues with performance and files 'being in use' by other
users.

NB: With <DownloadUpdates>true</DownloadUpdates> left as true, the central version will be
updated by the first person to launch 4Matrix if an update is pending. The update process will
complete, and then the files will be copied/cached to the client. There is a very minor risk that
multiple users could launch 4Matrix at the same time, in which case the update will try to apply more
than once and the files will become corrupt. If this happens, re-installing the 4Matrix client into the
shared location will resolve the issue.

An alternative option is to switch updates off and control these manually:

Option 2: The Cache Model with Manual Updates

e |Install the 4Matrix application to a shared folder on your server e.g. P:\Apps\4matrix

e (Create the LauncherSettings.xml file (as above) in this folder

e Set the Copylocal to <CopyLocal>true</CopylLocal> and CopyLocalPath to a path users have full
permission to e.g. <CopyLocalPath>%USERPROFILE%\4MatrixTemp</CopyLocalPath>

e |Leave CheckForUpdates to true, e.g. <CheckForUpdates>true</CheckForUpdates>

o Set DownloadUpdates to false e.g. <DownloadUpdates>false</DownloadUpdates>
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e C(Create a shortcut to P:\Apps\4dmatrix\Launcher.exe and share with staff e.g. place on their

desktop

When this shortcut is run, the software will check for updates but not download them. It will only
warn the user that an update is available, and they will see an option to open 4Matrix anyway.

To manually update the software the Network Administrator should:

e Ensure that no-one is running 4Matrix from this location (we suggest unsharing the folder
temporarily)

e Set DownloadUpdates to true e.g. <DownloadUpdates>true</DownloadUpdates> and save the
file
Run Launcher.exe to apply the updates
Set DownloadUpdates back to false e.g. <DownloadUpdates>false</DownloadUpdates> and save
the file

e re-share the folder (if required)

Notes

It is also possible to set a Custom Update Server if required, which means that 4Matrix checks a path
on your network for updates instead of the 4Matrix website.

If users do not utilise the <CopyLocal> option, it is likely to negatively impact on performanceand
4Matrix may even display errors due to 'time out' issues. This is because the files are being used
across the network, potentially by hundreds of users at the same time, instead of running locally.



Uninstalling 4Matrix

e To uninstall 4Matrix go to Control Panel > Programs and Features

® Choose 4Matrix and then select Uninstall

® Choose 4Matrix Network Manager and select Uninstall

e To delete the 4Matrix database go to Control Panel > Programs and Features and Choose

Microsoft SQL Server 2014 Express (or whichever version of SQL you are using) and choose

uninstall.

e |t will prompt you for which instance you’d like to uninstall. Do not do this if you are using it on

another instance!

e Delete any 4Matrix folders and their contents from the drive where you installed 4Matrix
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Updating Network Manager

This topic has been moved to separate document which can be downloaded from:
https://www.4matrix.com/help/update _network manager.pdf

47153


https://www.4matrix.com/help/update_help_new.pdf

Using Multiple Databases

The 4Matrix ‘Database Switcher’ no longer exists as a separate application.

Instead, we have now programmed Launcher.exe (when launched), to prompt which database you
wish to use, should it detect more than 1 on your system.

4Matrix references the Settings file in the 4Matrix folder, e.g. C:\Program Files (x86)\4Matrix\Settings
to determine which server and database to connect to. To connect to more than 1 database, you will
need a copy of the Settings file for each database. They will be identified using a ‘#’. These are
generated by the 4Matrix Network Manager tool on your server.

e In order to set this up, start by opening the 4Matrix client folder on the server where the
4Matrix Network Manager is installed i.e. D:\4Matrix\Client Files

e Duplicate the Settings file and rename the copy version to Settings#SchoolDataA

¢ Now open the 4Matrix Network Manager tool and make a backup of your database (this is
precautionary only)

¢ Now click Run Wizard

e Choose to create a new database at the relevant stage (call it something like SchoolDataB)

e Complete the rest of the wizard as normal

¢ Once back in the main Network Manager application, click the button that says ‘re-copy files’

e Go to your client install folder (i.e. D:\4Matrix\Client Files) and you should now see two
settings files, the one you renamed (Settings#SchoolA) and a new Settings (which actually
refers to your new SchoolDataB database). Check the date/time-stamp to be sure.

¢ Rename the new Settings file to Settings#SchoolDataB

¢ You should now have 3 Settings files in this folder; the original, called Settings, and then
Settings#SchoolDataA and Settings#SchoolDataB

e Copy both of the renamed Settings files to the client(s) which require access to more than 1
database (directory example: C:\Program Files (x86)\4Matrix). Note that you must keep the
original Settings file in place for this process to work. In this example, Settings#SchoolDataA is

a duplicate of the original Settings file:

| Settings
| Settings%SchoolDatak
| Settings#5choolDatab

¢ Now open Launcher.exe on the client (also in C:\Program Files (x86)\4Matrix) and it should

ask you which database you want to connect to. Note that the original Settings file is not
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shown as an option, which is why we have duplicated it as Settings#SchoolDataA:

£ Database Select [ - x

Please choose a database

SchoolDataA
SchoolDataB

Cancel

¢ When using a second or consecutive database for the first time, 4Matrix will prompt for a

licence key - use your School ID to licence your new database(s)
Notes:

Clients that should be restricted to using 1 database can still use a Settings File called 'Settings' - the

name doesn't matter, provided the information in the Settings file itself is correct and the client is
pointing to the correct database.
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Web Server Setup

This part of the Network Manager can be used to set-up 4Matrix Infinity - the free web add-on to
4Matrix Desktop. Please contact us for details on installation.

Database u} Tools u] Help u}

* " 'lnﬁzard e weh Semer I)e.taih
cted SHe

Restricted Access Beta [® X
PCVFOURTA

Please enter the beta password: .
=) pa pubh\matrixroot
wlarch1g CHRIS-PC
1 % cancel 3

g5 @ Change Update Server

http://www.4Matrix.com/update
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Disclaimers

This page has been intentionally left blank.
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Disclaimer (1)

You should always verify the totals appearing in any of the 4Matrix products independently before
reporting results. We do not accept any responsibility for the consequences of results that are
reported which are subsequently found to be incorrect for any reason - including the possibility of
calculation errors in 4Matrix itself. Our liability is limited to correcting any programming faults that
may be found.

Database: 4Matrix Desktop

We do not accept any responsibility under any circumstances for the consequences of a school
deleting any of its data or the 4Matrix database itself. The 4Matrix database should be backed up
regularly, either by using the Backup tool in the 4Matrix Network Manager application, or by using
the scheduled SQL database backup utility provided by Microsoft (instructions can be found in the
4Matrix Install guide). We also strongly recommend that backups are made prior to any significant
changes being made to the database, such as the merging of multiple subjects or deletion of
historical series.

Database: 4Matrix Fusion

We do not accept any responsibility under any circumstances for the consequences of a school
deleting any of its data. The 4Matrix Fusion database is hosted by 4Matrix on a virtual server. Daily
backups are made and kept for 5 days. Weekly backups are made and kept for 2 weeks.

Performance Measures

With regard to performance measures - we advise all schools to verify qualification statuses and
mappings (QAN's in use) using documentation which can be found on the DfE website, or by checking
with the relevant exam board before making any changes in the Edit Qualifications tool. By allowing
schools to manually set a qualification status and discount code, we will not accept any responsibility
for any inaccuracies reported in 4Matrix Desktop or 4Matrix Fusion where this information is found to
be incorrect.



Contact 4Matrix

Contacting 4Matrix

e Web: https://www.4matrix.com

e We offer a live chat facility at https://www.4matrix.com

e Helpdesk: https://help.4matrix.com

e Phone (sales, accounts, technical): 020 3475 4463

Social Media

e The 4Matrix Facebook Group, 1000+ members: https://www.facebook.com/groups/4matrixdata

e Twitter: https://twitter.com/4matrix
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